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OVERVIEW 

About RAMAR® 

 
RAMAR is a global provider of automatic meter reading systems for the utility industry. 
Through worldwide license and distribution agreements, RAMAR’s powerful product 
solutions enable water, gas, and electric utilities to improve customer service, cost-
efficiency, and meter reader safety. The company’s comprehensive product portfolio 
covers basic data capture devices for mobile meter reading to sub-metering systems 
and customized two-way fixed network solutions. 
 
RAMAR is one of the world’s leading designers and suppliers of radio frequency based 
(RF) automatic meter reading (AMR) systems. RAMAR’s focus is on developing cutting-
edge products for the AMR market, and the company’s development team is one of the 
largest most qualified in the world. RAMAR specializes in hand-held and mobile 
automatic meter reading, with a wide range of uses. Standard interfaces and protocols 
enable products to integrate with popular route management and billing software 
programs, hand-held computers, and meters. 
 

About ConFigIT® 
 

ConFigIT is the device that configures each TransPondIT, RAMAR’s meter interface 
until (MIU), prior to connection to a meter.  It enables the operator to program a number 
of parameters into the TransPondIT, including: utility code, MIU ID, meter reading, 
tamper count, transmit interval, meter type, meter read interval and meter model. The 
ConFigIT includes user-friendly software for quick and easy set-up. 
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PREFACE 

What is the purpose of this manual? 
This document was made to help users successfully program RAMAR’s TransPondIT 
using ConFigIT. 

Do I need to read the whole thing? 
No, this manual is broken down into tasks.  Make a note to read the sections that will 
help with your responsibilities. 

Getting Started – Hardware setup instructions for TransPondIT Installer or Office Staff 

Installing ConFigIT Software – TransPondIT Installer or Office Staff 

ConFigIT Software Operation – TransPondIT Installer or Office Staff 
Profile Editor Operation – TransPondIT Installer or Office Staff 

Where do I find information about installing the TransPondIT? 

  New 

RAMAR provides a TransPondIT manual and Technical Bulletins which cover specifics 
on meter interfacing and installation.  It is recommended that these materials are 
reviewed BEFORE beginning an installation. 
 
A RAMAR Quick Reference Guide is also available which covers the 900 series 
TransPondIT, ConFigIT, FastTrackIT and HandTrackIT.  Contact your RAMAR 
distributor for a copy of this guide. 

Where do I find information about developing my own ConFigIT software? 
RAMAR has a Software Developer Kit (SDK) which is available to all Business Partners.  
Contact RAMAR Technical Support for more information at 1-888-98-RAMAR. 

Who do I contact if I have a question? 
Questions not covered by this manual should be directed to the RAMAR supplier.  If a 
supplier is not available, contact RAMAR by calling 1-888-98-RAMAR. 
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1 CHAPTER - GETTING STARTED 
Overview – This section discusses which components are needed to setup and operate 
ConFigIT. 

Components of ConFigIT 
� Operating System - PC running Windows 98, NT, ME, 2000, or XP 

� ConFigIT Device 

� ConFigIT Software Version 5.6 

� Serial Cable 

� 4 - AA Alkaline Batteries or DC power supply 

� DC Power Cable (not pictured) 

 
Figure 1-1 

Components of ConFigIT 

1. Setting Up the ConFigIT Hardware 
1.1. Power Supply 

Newer models of the ConFigIT available August 2002 are equipped with both a 
battery compartment and a DC power jack.  The power jack allows a transformer to 
be used with a 120V AC wall receptacle. 
 

 
Figure 1-2 ConFigIT Power & Serial Connector 
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1.2. Batteries 

The ConFigIT can use four AA sized batteries.  The battery panel is located at the 
rear of the ConFigIT on the bottom.  Slide the access panel toward the rear of the 
ConFigIT to remove it.  Place the positive side of the battery on the side marked with 
the + plus sign in the ConFigIT. 
 
1.3. Connectors 

Newer models of the ConFigIT available August 2002 use a standard D-sub 9 pin 
RS232 cable on both ends of the cable.   
 

 
Figure 1-3 

ConFigIT RS232 Cable 

 
Older models of ConFigIT require a special RAMAR cable with a LEMO connector 
(Product ID: HND0PC03) for connecting to the ConFigIT.  When connecting the 
LEMO connector to the back of the ConFigIT box, ensure that the red dot on the 
connector and the red dot on the ConFigIT box are lined up. Insert the LEMO 
connector WITHOUT TWISTING. To release the LEMO connector grasp it as close 
to the red dot as possible then gently pull straight back. 

 

 

RED DOTS located 
on the bottom of 
the connectors 

Figure 1-4 
LEMO Connector 

 

Both versions of the ConFigIT cables have a female D-sub 9-pin connector for 
connecting to the PC serial port.  To attach the ConFigIT to a PC, connect the 
ConFigIT cable to the male 9 pin RS232 serial port on the PC.   
 
If the PC does not have a serial port, an external USB to serial adapter may be 
purchased from a local computer parts vendor.  Be sure to download the latest 
drivers for the appropriate operating system to ensure compatibility when using a 
USB to serial adapter. 
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2 CHAPTER – SOFTWARE INSTALLATION 
Overview – This section discusses the various software installations. 
 
2.1. Installation from 3½” floppy disk 

1) Insert Disk 1 into the 3 ½” floppy (A:) drive 

2) Click Start – Run and type a:\setup 

3) Accept all default values during setup 

4) Insert disk 2 when prompted 

 

2.2. Installation from CD 
1) Insert the disk into the CD ROM drive 

2) Double-click on My Computer 

3) Double-click on the CD ROM drive Icon 

4) Double-click on Setup 

5) Accept all default values during setup 
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3 CHAPTER – CONFIGIT SOFTWARE OPERATION 
Overview – ConFigIT is the device used to program and read values in the 
TransPondIT. The software and hardware are operated from a host PC and are 
designed for use in the field or an office environment. 
 
ConFigIT has two modes of operation, normal and profiled. Operation is the same in 
both modes with the exception that ‘profiled’ values such as the Utility Code cannot be 
changed.  If a TransPondIT is read which does not match the profile, then the erroneous 
values are shown in red. 

3.1. Starting ConFigIT 
To open the ConFigIT software, go to Start – Programs – RAMAR and click on the 
ConFigIT icon.  Alternatively, if a ConFigIT shortcut exists on the desktop, double-
clicking the shortcut will also open the ConFigIT software. 

NOTE: If there is no RAMAR folder in the Programs menu then the software is not 
installed.  See the installations instructions in Chapter 2. 
 

 
Figure 3-1  

ConFigIT Icon 

3.2. Software Registration 
WARNING - REGISTER SOFTWARE WITHIN 7 DAYS OR LICENSE WILL EXPIRE. 

1) To register go to the Help menu in ConFigIT and click License. 

2) If you want to register via email fill in the information and click Request else skip 

to step 6. 

3) A Vcard file is created at C:\Program Files\RAMAR\ConFigIT 

4) Email the Vcard to register@ramartech.com 

5) If you would prefer to call in dial 1-888-98-RAMAR (72627) M-F 8 – 5:30 EST. 
 
 
To start ConFigIT with a profile active, double-click a desktop shortcut or if ConFigIT is 
already open, select the profile name from the File -> Profiles menu.  To create a 
shortcut to a profile, open the profiles editor from the programs menu and check the box 
labeled ‘Show Desktop Icon’. 
 

mailto:register@ramartech.com
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Figure 3-2 

ConFigIT Activating a Profile 

 
Once a profile is active it cannot be deactivated or changed without exiting and 
restarting ConFigIT. 
 

 TIP – To create a shortcut for ConFigIT on the desktop, expand the menu system 
from Start -> Programs -> RAMAR; right-click the ConFigIT item and click copy. Right 
click on the desktop and click Paste Shortcut. 

3.3. Reading a TransPondIT 
Once the ConFigIT software is open, the only button not disabled is Read. A 
Read must occur so that the software can determine what type of TransPondIT is 
in the ConFigIT. Fully insert a TransPondIT in ConFigIT and click the Read 
button to enable the software. If a mouse is unavailable, pressing Alt-R will also 
perform a read.  Similarly, all fields and buttons with an underlined letter have an 
Alt-key function. 

 

  
Figure 3-3 ConFigIT with TransPondIT 

During the read, the green OK light on the ConFigIT will light up and the orange BUSY 
light will flash.  Once the read is finished the programmed values are displayed.   
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Figure 3-4  ConFigIT Interface 

 TIP - The software has been designed to use the Tab key to move from field to field 
in case a mouse or pointer device is not available. 
 

3.4. Overview - Setting a TransPondIT 
The ConFigIT software needs to know what type of TransPondIT is in the ConFigIT 
before any values can be set.  To determine the type of TransPondIT a read must be 
performed by clicking the Read button or by pressing Alt-R.  Fields that need to be 
configured are shown in the table.  If the Profile Editor is used most fields below will be 
automatically set and do not need input from the operator.  Refer to the Profile Editor 
section in this manual for more information. 
 

Table 3-1 – TransPondIT values 

Meter Interface Values Description Set by Profile Editor 

Pre Scale (Pulse 
only) 

1,2,10, 20, 100, 
200, 1000, 2000 

Scales down the meter 
output 

Yes 

Read Interval 
(Encoded only) 

1.25, 2.5, 5, 10 
hours 

Time between readings Yes 

Tamper Count 
(Pulse only) 

0 - 255 Counts tamper wire 
disconnects/connects 

No 

Status 
(Encoded only) 

0, 64, 65… Indicates communication 
problem with meter 

No 
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Meter Interface Values Description Set by Profile Editor 

Utility code 0 - 255 Number given to customer 
by distributor to ensure 
uniqueness of transmitter 

Yes 

TransPondIT ID Pulse: 0 - 
16,777,215 
 
Encoded: 0 – 
9,999,999 

ID stored in transmitter; 
either programmed by the 
user or collected 
automatically from the 
meter 

Yes – Range is 
specified for 
programmable 
TransPondIT 

Meter Reading 0 - 16,777,215 Transmitted reading No – Programmed by 
user (pulse) or read by 
TransPondIT 
(encoded)  

Transmit Interval 5, 10, 20 
seconds 

Interval between 
transmissions 

Yes 

 

3.4.1. Using Auto Increment 
ConFigIT allows the programmer to set a starting point for a range of ID’s to be 
programmed in sequence.  To use Auto Increment type the first ID number in 
the TransPondIT ID field and check the Auto Increment box or press Alt-A. 
 

 
Figure 3-5 Auto Increment 

3.4.2. Setting a Pulse TransPondIT 
A pulse TransPondIT counts switch closures using a mechanical device within 
the meter or retro-fitted to the exterior of the meter. 
 
Fields that are specific to the pulse interface are: 
 

Table 3-2 Pulse Type Interface Values 

Fields Comments 

Pre Scale TransPondIT kernel versions 
2.5 and later offer more 
choices for this field. 
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Tamper This value will increment each 
time the tamper wire is 
removed and reconnected. 

Meter Reading Determined by pulses as a 
ratio of the Pre Scale value 

TransPondIT ID Programmed by user 
 
A visual read of the mechanical meter can be taken at the time of installation and 
the reading can then be configured using the Meter Reading input field. 
 
To determine Pre Scale find out what units the system is billing in and then 
determine the number of units represented by each pulse.   
 
Example 3-1 
ConFigIT Pre Scale 

Billing is done in 1000 gallon increments. 
Billing Units = 1000 gallons 

The meter generates a pulse for every 10 gallons. 
  Meter Units = 10 gallons 
 

To determine pre-scale divide the billing units by the meter units. 
 1000 / 10 = 100  
 
Therefore 100 is the correct Pre Scale in this example.  Once all the 
values have been selected and entered click the Set button.  Note that if a 
mouse is not available pressing Alt-S will also perform the Set function. 

 

 
Figure 3-6 ConFigIT Set Button 

It is not necessary to perform a read after a set, this is done automatically. 
 

The ConFigIT software will not allow invalid settings to be stored in the 
TransPondIT.   
 
If the TransPondIT being programmed is not recognized by the software then 
contact RAMAR for an update. 

3.4.3. Setting an Encoded TransPondIT 
Encoded meters communicate directly with the TransPondIT providing 
information such as the reading and/or meter ID. 
 
Some encoded meters may not require programming the TransPondIT ID.  Refer 
to the following table for more information. 
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Table 3-3 Encode Type Interface Values 

Meter Interface TransPondIT 
Model # 

ID can be extracted 
from Meter? 

Comments 

ABB Scancoder 915-03-20 Yes  

ECR 915-04-20 Yes Drops most significant 
digits. 

ARBV 915-05-20 No ID is not provided by the 
meter 

Pro Read / Auto-
detect 

915-06-20 Yes Model X6-12 requires the 
ID to be programmed 

 
For 04-20 and newer models we drop the most significant digits (left most) so 
that the ID will fit in the TransPondIT ID field.  If there is a problem with duplicate 
ID’s the customer can get additional utility codes from the distributor or RAMAR. 
 
Example 3-2 
ECR ID Extraction Model 04-20 

The meter has an ID number of 12345678.  
 

The TransPondIT reads the ID and drops the left most digits so that the ID has 7 
digits.   
 
The ID stored in the TransPondIT = 2345678. 
 
For TransPondIT models X4-12 and older we subtract 16,777,215 from the Meter 
ID until it is lower than 16,777,215.   
 
For more information on a specific application please review RAMAR’s technical 
bulletins which can be obtained from your distributor or directly from RAMAR. 

 
Once all the values have been selected and entered click the Set button.  Note 
that if a mouse is not available pressing Alt-S will also perform the Set function. 
 

 
Figure 3-7 ConFigIT Set Button 

 
It is not necessary to perform a read after a set, this is done automatically. 

 
The ConFigIT software will not allow invalid settings to be stored in the 
TransPondIT.   
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If the TransPondIT being programmed is not recognized by the software then 
contact RAMAR for an update. 

 

 TIP - The ConFigIT hardware will stay powered on for one minute which is indicated 
by the green LED.  During this time the green OK LED will flash each time the ConFigIT 
receives a signal from the TransPondIT. 
 
3.5. Turning Off Transmitter 
The Sleep button allows the operator to turn off the TransPondIT transmitter.  Selecting 
OFF in the Transmit Interval drop down menu and clicking the Set button will also turn 
off the transmitter. 
 

 
Figure 3-8 

ConFigIT Sleep Button 

3.6. Revert 
The purpose of the Revert button is to allow the operator to Read another TransPondIT 
without losing the settings from the previous TransPondIT.   
 
The Revert button becomes active (not grayed out) after the operator performs a Read 
on a TransPondIT containing different values.  The Revert button changes the settings 
back to what was configured before the Read occurred. 
 

 
Figure 3-9 

ConFigIT Revert Button 

Example 3-3 ConFigIT Revert Button 

The software settings show the following: 
Table 3-4 Settings in ConFigIT 

Meter 
Interface 

Pre 
Scale 

Tamper / 
Status 

Reading Utility ID TX Interval 
(sec) 

Pulse 1 0 1202 29 2345 5 
 

A read is performed on a TransPondIT which displays the following values: 
Table 3-5 ConFigIT Settings after Read 

Meter 
Interface 

Read 
Interval 

Tamper / 
Status 

Reading Utility ID TX Interval 
(sec) 

ECR TM 2.5 64 0 14 16777215 Off 
 

Notice now that the Revert button is active.  Clicking the Revert button will change 
the settings back to those in Table 3-4 Settings in ConFigIT. 
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4 CHAPTER – PROFILE EDITOR OPERATION 

Overview – Profiles eliminate the possibility of making a mistake such as programming 
the wrong meter interface. This is accomplished by providing the default values that can 
be programmed into a profile. 

4.1. Opening the Profile Editor 
To open the Profile Editor go to Start – Programs – RAMAR and click ConFigIT Profile 
Editor. 
 

 
Figure 4-1 

ConFigIT Profile Editor 
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4.2. Profile Editor Operation 
Profile Editor locks certain settings that will be configured into the TransPondIT.  The 
Profile Editor interface consists of two areas: Name and Profile. 

4.2.1. Name 
This area allows profiles to be created, renamed and edited. To create a profile 
click on the New button and enter the profile name.  The name can be anything 
relevant. 
 
Next, choose the desired meter interface from the drop down menu labeled 
‘Profile applies to Meter Interface’.  Click OK. 
 

 
Figure 4-2 

Profile Editor Creating a Profile 

Now the profile has been given a name and assigned a meter interface.  Click 
the check box for ‘Show Desktop Icon’.  After a few seconds a RAMAR 
ConFigIT logo appears on the desktop with the name of the profile. 
 
The option ‘Show Menu Item’ may be also be checked to put a shortcut in Start 
– Programs – RAMAR. 

4.2.2. Profile 
The Profile area is where the utility code, TransPondIT ID and timing intervals 
are selected. Enter the Utility Code provided by your distributor.  RAMAR assigns 
unique codes to each Business Partner. 
 

 
Example 4-1 

Profile Editor Utility Code 
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Note only one meter interface and utility code can be selected for a profile.  If the 
meter interface is encoded then the Meter Read Interval is programmed here.  If 
the meter interface is pulse then the Pulse Pre Scale is programmed here. 
 
Enter the Pulse Pre Scale value or Read Interval, for details on this see 3.4 
Overview - Setting a TransPondIT in Chapter 3. 
 

 
Example 4-2 

Profile Editor Pre Scale and Transmit 

 
Select the Transmit Interval from the drop down menu.  5 seconds is the 
recommended transmit interval. 

4.2.3. Using Profiles in ConFigIT 
The recommended method for using a profile in ConFigIT is to create a shortcut 
of the profile on the desktop using the checkbox option in the Profile Editor.   
 
Alternatively, a shortcut can also be created to the profile in the program menu 
using the checkbox option in the Profile Editor.   
 
The last method for using a profile is to open ConFigIT and choose the profile 
from the File menu.   
 
Once a profile has been selected in ConFigIT from the File – Profile menu, the 
only way to exit the profile is to exit and re-open ConFigIT. 
 

 
Figure 4-6 

ConFigIT Opening a Profile 

 

 TIP - Remember that TransPondIT IDs are not recorded by ConFigIT.  
Therefore, it is possible to generate duplicate IDs. It is up to the user to control 
ID allocation. 
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A APPENDIX – TROUBLESHOOTING 
Overview – This section describes how to determine the cause of failure with the 
ConFigIT software and hardware. 
 
1. Error Messages 

1.1. No TransPondIT Detected 
ConFigIT communicates with the TransPondIT using an electro-magnetic coil to 
open and close a switch inside the TransPondIT.   
 
If an error occurs that states ‘No TransPondIT detected in ConFigIT’ ensure that 
the TransPondIT is fully inserted into the ConFigIT.  If the TransPondIT still is not 
detected by ConFigIT try flipping it over. 
 
1.2. ConFigIT Not Responding on Com Port 
Read next sections. 
 

2. Checking the Connectors and Power 
Is ConFigIT plugged in? 
 
Is the cable or connectors visibly damaged?  Be sure to inspect the male serial 
connector on the PC and the LEMO connector on the cable.  One of the most 
common causes of failure is twisting the LEMO connector. 
 
Are there batteries in it or is it plugged into a working AC outlet?  ConFigIT will not 
run off the power from the PC. 
 
Are the batteries good?  ConFigIT will issue a low battery warning within the 
software if the voltage drops too low but will continue to operate for some time.  
Once the batteries are too low to operate the ConFigIT the OK light will blink when 
ConFigIT is opened. 
 
3. Checking the COM port 

3.1. Is another program using the COM port? 
Example 1:  Modem connected to Internet Service Provider 
Example 2:  HotSync program for PDA device 

 
3.2. Select the correct COM port – To choose the COM port click File – 

Interface then the COM port. 
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Figure A-1 
COM Port 

Once the correct COM port is selected perform a read.  The Status light at the 
bottom of the ConFigIT software will change from Not Ready to Ready. 

 

 
Figure A-2 

ConFigIT Status Not Ready 

   
Figure A-3 

ConFigIT Status Ready 

 
3.3. Windows 98 & ME – Right-click My Computer and choose Properties.  Click 

the Device Manager tab.  Double-click Ports and double-click the COM port 
that ConFigIT is plugged into.   

 
3.4. Windows 2K & XP – Right-click My Computer and choose Properties.  Click 

the Hardware tab.  Click the Device Manger button.  Double-click Ports and 
double-click the COM port that ConFigIT is plugged into. 

 
4. Use Module Substitution – By substituting known good working parts for the 

suspect parts, it can be determined which piece of hardware is causing the 
failure. 
 
4.1. Try a Different Cable 
If there is a known good ConFigIT cable, try replacing the suspect cable.   
 
For customers purchasing ConFigIT after August 2002, the new 9 pin connection 
will be provided instead of the LEMO connector. 
 
For versions of ConFigIT purchased before August 2002 the PC to HandTrackIT 
cable (part number HNDPC02) can also be used with ConFigIT.   
 
If the new cable works then the cable needs to be replaced.  The cable pictured 
in Figure 1-3 
ConFigIT RS232 Cable is a standard 9 pin serial data cable which may be purchased 
through your distributor or from any computer supply store. 

 
4.2. Try a Different Computer 
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Is there another computer that works with ConFigIT?  If the suspect ConFigIT 
does not work with this PC it may need to be replaced.  Contact your distributor 
for a replacement. 

AT RAMAR LLC LIMITED LICENSE AGREEMENT 
THIS IS A LEGAL AGREEMENT (“AGREEMENT”) BETWEEN YOU, THE END USER ("USER" OR 
"YOU"), AND AT RAMAR LLC (“RAMAR”). CAREFULLY READ ALL THE TERMS AND CONDITIONS 
OF THIS AGREEMENT PRIOR TO USING THE SOFTWARE THAT IS INCLUDED WITH THIS 
AGREEMENT OR THAT IS DESCRIBED IN THIS DOCUMENTATION (AS APPLICABLE). BY USING 
THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, WITHIN THIRTY 
DAYS AFTER RECEIPT, DELETE ALL COPIES OF THE SOFTWARE AND RETURN THE SOFTWARE 
AND THE ACCOMPANYING PRODUCT (INCLUDING ALL HARDWARE, EQUIPMENT AND 
DOCUMENTATION) TO THE PLACE WHERE YOU PURCHASED THE PRODUCT FOR A FULL 
REFUND. 

LIMITED LICENSE 
This Agreement sets forth User's rights to use the Software and all documentation accompanying the 
Software (the “Documentation”), which are the proprietary and copyrighted material of RAMAR. 
Collectively, the Software and the Documentation are referred to in this Agreement as the "Licensed 
Materials." Upon receipt of the applicable fee, RAMAR grants to User the personal, non-exclusive, and 
non-transferable right to use a single copy of the Software in the United States of America, subject to the 
restrictions in this Agreement. 

UNDER THIS LICENSE, YOU MAY: 
Install and use the Software components as described below; and 

Make a single copy of the Software, solely for backup purposes. 

SOFTWARE COMPONENTS 
The following component(s) of the Software may be used only on a single computer hardware system 
with a single CPU and solely with the hardware delivered with the Software: 

ConFigIT 

The remaining components of the Software may be used in addition on a second computer hardware 
system with a single CPU located at your location, and only for your internal business purposes. 

YOU SHALL NOT: 
Use, copy or transfer copies of the Licensed Materials, except for backup purposes as provided in 
this Agreement. In particular, you shall not copy the Software for use on hardware other than the 
hardware delivered with the Software, except with the written consent of RAMAR;  

Make the Licensed Materials available on a local area network so that it can be accessed by 
more than one user at a time; 

Disassemble, decompile or otherwise reverse engineer the Software in order to discover the 
source code or related proprietary information and trade secrets, or have a third party do so;  

Rent, lease, sublicense, distribute, transfer, modify or timeshare the Licensed Materials; or 

Place the Licensed Materials on a Bulletin Board System, the Internet, or other on-line service or 
system. 

PROPRIETARY RIGHTS 
RAMAR owns all proprietary rights, including all copyrights, patents, and trade secrets, in and to the 
Software, including but not limited to all associated Documentation, methodologies, algorithms, software, 
extensions, logic flows, data structures, and screen displays. RAMAR also owns the magnetic or other 
physical media on which the Software is recorded. The Software source code and related proprietary 
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information and trade secrets are not licensed to User, and any modification, addition or deletion is strictly 
prohibited. User agrees to take all reasonable steps to prevent unauthorized disclosure, use or copying of 
the Licensed Materials. User also agrees to include in the backup copy of the Software all RAMAR 
copyright and proprietary notices. RAMAR reserves all rights not expressly granted to User. 

RESPONSIBILITIES OF LICENSEE 
As a licensee of the Software, you are solely responsible for the proper installation and operation of the 
Software in accordance with the instructions and specifications set forth in the Documentation. RAMAR 
shall have no responsibility or liability to you for improper installation or operation of the Software.  

TERM 
This Agreement is effective until terminated. User may terminate this Agreement by returning the 
Software and all copies thereof. This Agreement will also terminate if User fails to comply with any term or 
condition of this Agreement. User agrees, upon such termination, to destroy all copies of the Software or 
return them, postage prepaid, to RAMAR at the address set forth below. Except as provided in the 
following section, returning the Software to RAMAR following the opening and/or use of the Software will 
not entitle User to a refund. 

LIMITED WARRANTY 
THE SOFTWARE IS PROVIDED “AS IS.” RAMAR DOES NOT WARRANT THAT THE SOFTWARE 
OR DOCUMENTATION WILL SATISFY YOUR REQUIREMENTS OR THAT THE SOFTWARE OR ITS 
DOCUMENTATION ARE FREE OF ERRORS OR DEFECTS OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED. 
RAMAR SPECIFICALLY DISCLAIMS ALL WARRANTIES, REPRESENTATIONS AND CONDITIONS 
RELATING TO THE SOFTWARE, EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTY OF CONDITION OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE OR ANY IMPLIED WARRANTIES ARISING FROM A COURSE OF DEALING. ALL OTHER 
IMPLIED TERMS ARE EXCLUDED.  
YOU ACKNOWLEDGE AND AGREE THAT YOU SHALL BEAR THE ENTIRE RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE SOFTWARE. RAMAR SHALL NOT BE LIABLE FOR ANY 
CLAIM OR RIGHT TO RECOVER ANY DAMAGES, INCLUDING BUT NOT LIMITED TO, LOST 
PROFITS, LOSS OF DATA OR LOSS OF USE OF THE SOFTWARE OR ANY OTHER KIND OF 
DIRECT, SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES, EVEN IF RAMAR 
HAS BEEN EXPLICITLY INFORMED ABOUT THE POSSIBILITY OF SUCH DAMAGES. IN NO CASE 
SHALL RAMAR’S LIABILITY EXCEED THE PRICE YOU PAID FOR THE SOFTWARE. 

GENERAL PROVISIONS 
Entire Agreement. This Agreement sets forth the entire understanding between User and RAMAR with 
respect to the subject matter hereof. This Agreement may be amended only in a writing signed by both 
parties. No vendor, distributor, dealer, retailer, sales person or other person is authorized to modify this 
Agreement or to make any warranty, representation or promise which is different than, or in addition to, 
the representations or promises of this Agreement. 

Export. Export of the Software and the Documentation outside of the United States is subject to the 
Export Administration Regulations of the Bureau of Export Affairs, United States Department of 
Commerce. In the event User desires to export the Software outside of the United States, User, at its own 
expense, shall comply with all applicable regulations governing such export. RAMAR makes no warranty 
relating to the exportability of the Software to any particular country. 

Other. No waiver of any right under this Agreement shall be effective unless in writing, signed by a duly 
authorized representative of RAMAR. Failure to insist upon strict compliance with this Agreement shall 
not be deemed a waiver of any future right arising out of this Agreement. This Agreement shall be 
governed by and construed in accordance with the laws of the State of North Carolina. You agree that 
sole jurisdiction and venue for any dispute arising under this Agreement shall be in a state or federal court 
in Wake County, North Carolina. If any provision of this Agreement is held by a court of competent 
jurisdiction to be invalid or unenforceable, such provision shall be fully severable, and this Agreement 
shall be construed and enforced as if the illegal, invalid or unenforceable provision had never been a part 
of this Agreement. You may not assign or transfer this Agreement, and any such attempted assignment 
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or transfer shall be null and void. The prevailing party in any action to enforce this Agreement shall be 
entitled to recover its reasonable attorney’s fees from the other party.  

If you have any questions concerning this Agreement, please contact AT RAMAR LLC at (919) 991-9924, 
P.O. Box 110127, Research Triangle Park, North Carolina 27709-0127. 
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